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About the Tutorials 
This chapter consists of seven tutorials.  You have selected the one that is highlighted in red: 

•  Tutorial 1 - Fundamentals 

•  Tutorial 2 - Working with Channels 

•  Tutorial 3 - Triggering 

•  Tutorial 4 - Working with Special Modes 

•  Tutorial 5 - Working with Subchannels 

•  Tutorial 6 - Arbitrary Waveform Generator 

•  Tutorial 7 - Using the Graphical Waveform Editor 

Each section is a self-contained tutorial. If you are new to GageScope®, it is recommended 
that you do the tutorials in the order they are presented, as each section assumes you have 
gone through the previous material. 



Tutorial 7: Using the Graphical Waveform Editor 

The graphical waveform editor allows onscreen viewing and editing of waveforms. Complex 
signals can be created with relative ease using the graphics editing capabilities of GageScope® 
software. The complex waveforms created can then be uploaded to an arbitrary waveform 
generator for use in scientific applications. These features have been explained in an 
illustrative example below. 

We will work on a gaussian pulse that has been created and saved as a .sig file in a local 
directory. The objective is to produce a non-gaussian shaped pulse using the graphical editor 
within GageScope. It has been assumed that GageScope® has been launched prior to 
following these steps: 

Waveform Editing Procedure 
1 Click File --> New --> Generator --> Equation --> Load. The file Open dialog box 

appears: 

 

2 Click gaussian.egg from the list in the dialog box. Gaussian.egg will appear in the File 
name text box.  Click Open. The New dialog box opens as follows: 

 GageScope® - Part B 



 

3 Click OK. GageScope® will display the gaussian pulse as follows: 

 

Note: The pulse has been expanded in time and displayed at the center of the display 
window in Gagescope.  Refer to the System and Display Control sections in the 
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Chapter titled, Reference, of this manual for details on how to adjust these settings.  

We have selected a gaussian pulse to be edited using the graphical editor for the purpose 
of demonstration. You can either select any other stored waveform or create a new 
waveform using the mathematical equation editor. 

4 Right click on the reference line of the displayed signal. You will observe that the cursor 
changes shape, the waveform changes color and a menu appears at the right click 
position.  

This menu is shown as follows: 

 

5 Double click on Edit to enter the Graphical editor. At this stage, you may be warned 
that for the current time base, only limited editing is available.  

The warning message is displayed as follows: 

 

If you enter Yes, basic editing features like Copy, Cut, and Paste will be available. The 
graphical editing to change the waveform will be available only when the time base is 
expanded to 2 microseconds per division.  
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6 Since we are not ready for editing the waveform, click No. You will get back to the 
GageScope® display with the gaussian pulse shown on Channel 1. 

 

7 At this stage, if you click Yes, you will enter the graphical editor but will not be able to 
use any of its features. You must see a few Nodes on the waveform to commence the 
editing process. A node is a point on the trace surrounded by a square.  

 

The figure above shows a selected segment to be edited. Note that the edited segment 
shows three nodes. The end points of the segment are the boundary nodes. The middle 
node is the one that has been created (node creation to be explained later) or is an 
already existing node. The middle node is termed as the control node. The control node 
will be used to modify the selected line segment. 
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Note that the control node is shown with two orthogonal lines with arrows at the end. 
The mouse pointer changes shape to the one shown above when this node is selected for 
editing.  
 
You can select a segment with just the boundary nodes and then create the control node 
anywhere within the segment OR you can select two segments with the middle node as 
the control node. 
 
The important point to remember is that we must have three nodes within a selected 
signal segment to modify the segment.  

When cursor is placed on a node to be selected for editing, it changes into a four way 
arrow as  

8 Expand the time base by clicking  . Keep redisplaying the portion of the signal to 
be edited by using GageScope® display’s horizontal scroll bar every time you adjust the 
time base. The display below shows an expanded view of the gaussian pulse: 

 

9 After expanding the time base and redisplaying the signal as shown above, make 
another attempt to launch the graphical editor. 

Right click on the zero reference line. The cursor will change shape and the window 
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display context menu will appear. Double click on Edit to launch the graphical editor. 
One of the following will happen: 

• If the trace is still too dense, the GageScope® warning window will reappear. 
This indicates that the time base has not been expanded enough for the editor 
to function. 

• In such a case, click No. You will get back to the expanded display. Click on 
the time base expand button, , to expand the time base even further. 
Try launching the graphical editor again by right clicking on the zero 
reference line and selecting Edit from the drop down menu. 

• If the time base is proper for the editor to function, you will see the following 
display: 

 

10 Note that the trace is now divided into four segments and hence there are five nodes 
shown on the trace. You can select any segment for editing purposes. Since the 
displayed portion of the waveform shows the nodes, it implies that we are now ready for 
graphical editing. 

 To start editing the displayed portion of the waveform, you can either use the existing 
Nodes or create new Nodes. 
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Using the Existing Nodes 
 
11 Place the cursor on any portion of the waveform. The cursor changes from an arrow to 

be a plus sign +. This shows that a point on the trace has been selected, as depicted in 
the figure below: 

 
12 Move the hairline cursor closer to a Node. You do not have to move along the trace. You 

can go directly to the Node.  

Once you are in the neighborhood of a Node, you will notice that the hairline cursor 
changes into a four-way arrow, . This signifies that this particular node is now a 
control node and can be used to alter the trace.  The figure below shows the trace with 
the control node: 
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13 To move the control node, click the left mouse button once. This action activates the 
four-way arrow and now we are ready for editing.  Press the left mouse button again and 
move the cursor as desired. Since we wish to make a gaussian pulse, non-gaussian, we 
will move the peak point to the left as shown in the figure below: 
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Observe that the peak has been shifted to the left making the pulse non-gaussian. 

Note that the procedure employed in the drag and drop editing process, is the Cubic 
Spline Interpolation, which has been selected as a default. The Cubic Spline 
interpolation procedure works on fitting a cubic polynomial within a selected interval. 
In the example above, the selected interval is the interval between the two nodes: the 
nodes on the left and right of the control nodes define the left and right boundaries of 
the selected portion of the waveform. When the user moves the control node, the editor 
fits a cubic curve in between the two boundary nodes. This curve passes through the 
selected node as well as the two boundary nodes. 

14 You can also select the straight line interpolation procedure too by selecting Straight 
from the interpolation submenu. While in the Edit mode, right click on any portion of 
the display. You will see following context menu: 

  

Note that Cut, Copy, and Paste operations are not available since the portion of the 
waveform to be edited for cut and paste  operations has not been selected as yet. These 
items will be available for use whenever a portion of waveform is selected by placing 
the cursors on the trace for editing.  The cutting, pasting and copying procedure has 
been outlined in the section to follow. 

15 Select Interpolation to view the submenu as follows: 

 

Spline is shown as the default interpolation option.  
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16 Select Straight option in the menu above. This option connects the three nodes, the 
control node, and the two boundary nodes, by straight lines as shown below: 

 



 
Creating New Nodes 
17 New nodes can be created with absolute ease in the Graphical waveform editor. Newly 

created nodes impart user extreme flexibility to reshape the waveform arbitrarily. 

Follow the steps to get to the following displayed waveform in GageScope: 

 
18 Move the cursor to the desired location on a selected portion of the waveform. This is 

the location where you wish to create a new node. You will note that the cursor changes 

shape to be a plus sign +. 
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19 Double click on the selected point and the cursor changes shape to look like .  

 

20 At this juncture, you have created a new node at this location. To view the newly created 
node, move the cursor away. You will see the following: 
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You can now use this new node to edit the selected portion of the trace. 

Deleting Existing Nodes 
21 Existing nodes can be deleted by simply double clicking on the Node. 

Follow the steps to get to the following displayed waveform in GageScope: 
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22 Move the cursor to the node that you wish to delete. We have selected the middle node 
to be deleted. 

Move the cursor to the desired node.  The cursor changes to be a four-way arrow.  
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23 Double click to remove the selected node. 

 

 



Cut, Copy and Paste Features 
These features are available to the user whenever the desired portion of the waveform is 
selected using the cursors provided in GageScope® software. 

Cut and Paste Operations  

The example below illustrates how the Cut and Paste features work within the GageScope® 
software. 
 
1 Before carrying out example below, make sure that GageScope® display is configured as 

follows: 

 

Note that the Channel control area in the lower right corner of the GageScope® display 
appears blank. This is because no arbitrary waveform generator related signal has yet 
been created or loaded. Also note that the CG1100 tabs in the System control and 
display controls have been selected and the CG1100 related display window is shown 
maximized. 

2 Open the file titled 5 Flavors.egg by carrying out the steps as follows: 

Click File --> New --> Generator --> Equation. The New dialog box opens: 
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3 Click Load. The file Open dialog box appears: 

 

4 By default, the contents of the AWG Equations folder appear in the file Open dialog 
box as shown in the above.  

Select the file named 5 flavors.egg. The name of the selected file appears in the File 
name text box. Click Open. The New dialog box appears again: 
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Note that the right hand portion of the New dialog box shows the exact composition of 
the signal to be displayed in GageScope. The signal certainly contains 5 types of 
waveforms. 

5 Click OK to load the signal. GageScope® will display the signal as follows: 

 

In case the signal does not appear exactly the same as in the figure above, you may have 
to align the trigger to the left and compress the timebase to make the signal match the 
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one shown above. 

Click the left trigger align Icon  to align the trigger to the left. Click on the timebase 
expansion  or compression  buttons in the display control area to adjust to 
the timebase to exactly match the display settings as shown in the figure above. 

6 The next step is to invoke the Edit Mode. In order to achieve this end, place the cursor 
on the signal zero reference line. The cursor will turn into a move pointer.  

Right click to view the context menu: 

 

7 Note that Edit is the last option in the context menu. Click Edit to enter the graphical 
editing mode. The following dialog box appears: 

 

This message informs you that the current timebase settings allow limited editing 
features. This means that you may have to expand the timebase to be able to utilize full 
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editing capabilities. Since the timebase settings are frozen in the Edit mode, you will 
have to click No to go back to the non-edit mode and expand the timebase by clicking 
on  button in the display control. After having expanded the timebase, you can 
again attempt to launch the graphical editor by clicking Edit in the windows context 
menu. This is an iterative procedure and we do not want to embark on this route. 

8 We have opted to select Yes. The waveform graphical editing mode is now invoked. You 
will view the original waveform. 

At this stage, click one after the other on the left  , and right cursor  , icons in 
the toolbar. The GageScope® display will show both the cursors at default locations: 

 

9 Place the mouse pointer anywhere on the left cursor.  The mouse pointer will change 
shape to a move pointer.  Hold down the left mouse button and drag the move pointer. 
The cursor will drag with the pointer. Release the left mouse button at the starting 
location of the waveform to be edited. Follow the same procedure for the right cursor.  

In this example, we have decided to cut out the sine portion of the trace. This portion 
will be inserted in between the last part of the trace.  
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You can observe that the sine portion of the signal has been selected. 

10 Right click anywhere on the display (except the zero reference line). You will see the 
display context menu as follows: 

 

The Cut and Copy commands are grouped together at the bottom of this window. 

11 Double click on Cut to select and execute the command.  You will see that the selected 
portion of the signal has been removed from the display and both left and right cursors 
collapsed to show a single cursor.  You must understand that both cursors exist as 
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separate entities. It's just that they seem to be one. 

 

12 Hide the right cursor by clicking on the respective icon  in the toolbar.   

 

Observe that the sine portion of the signal has been removed. The portion to the right of 
the cut part has moved to the left to glue with the left part of the signal.  

Note that the right cursor icon appears enabled in the toolbar. 

 

22 Tutorials 



Tutorials 23 

13 Place the mouse pointer on the left cursor, hold down the left mouse button, and drag 
the cursor to the desired insertion point on the displayed waveform. Release the left 
mouse button. You will see the following display with the left cursor positioned at the 
desired insertion point: 

 

Note that the insertion point has been arbitrarily selected. If you wish, you can select 
any other paste location. 

 

14 Right click anywhere within the display window. The display context window will 
appear again as shown below: 



 

Make sure that you do not right click on the zero reference line. Right clicking on the 
zero reference line brings up the channel context menu. 

15 You can see that the Cut and Copy commands have been disabled.  Only the Paste 
command is shown enabled at the bottom of the display context menu. 

Double click on Paste to insert the cut portion of the trace. The modified signal will be 
shown as follows: 
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16 Hide the cursor by clicking on the left cursor button   in the toolbar: 

 

17 You will note that while in the edit mode, most of the functionality in GageScope® 
remains disabled.   

Click on the channel 1 tab in the bottom of the Channel Control. Click on the AWG 
Input tab to bring it to front.  The AWG Input property page will appear and is shown 
as follows: 

 

Channel 1 (Ch 01) contains the signal you have just modified.  In order to get back to 
the normal functionality, you will have to leave the Edit Mode. 

18 Click on the File menu in the menu bar. The File menu will be displayed: 



 

Note that the Save Setup, Load Setup, New, and Load Channel commands have been 
disabled. These will be re-enabled once you leave the Edit mode. 

19 Click on Capture in the main menu. The Capture menu will appear: 

 

Note that the entire Capture menu has been disabled. These features are not needed 
while editing of signals is in progress. 

20 Click on Tools in the main menu bar.  The Tools menu will appear: 

 

Note once again that the entire menu has been disabled since these functions are not 
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required when editing of a waveform is in progress. 

21 Click on Windows in the main menu bar.  The Windows menu will appear: 

 

You can see that the New Display command is disabled. While in the edit mode, you are 
not allowed to create another signal. In other words, only one signal can be modified at 
a time. 

22 We have finished editing the waveform and now must exit the Edit Mode.  In order to 
do so, move the mouse pointer to the zero reference line. The mouse pointer will turn 
into a move pointer.  Right click on the zero reference line of the waveform.  The zero 
reference context window will appear as follows: 

 

The check mark indicates that the Edit Mode is in force. Double click on Edit. This will 
take GageScope® out of the Edit Mode. You will note that the functions that were 
disabled will now be restored to their original settings.  
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Copy and Paste Operations  

The example below illustrates how the Copy and Paste features work within the GageScope® 
software.  
 

1 Open the file titled Lorentzian.egg by carrying out the steps as follows: 

Click File --> New --> Generator --> Equation. The New dialog box opens: 

 

2 Click Load. The file Open dialog box appears: 
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3 By default, the contents of the AWG Equations folder appear in the file Open dialog 
box as shown above.  

Select the file named Lorentzian.egg. The name of the selected file appears in the File 
name text box. Click Open. The New dialog box appears again: 

 

Note that the right hand portion of the New dialog box shows the exact composition of 
the signal to be displayed in GageScope.  

4 Click OK to load the signal. GageScope® will display the signal as follows: 

 



 

In case the signal does not appear exactly the same as in the figure above, you may have 
to align the trigger to the left and compress the timebase to make the signal match the 
one shown above. 

Click the left trigger align Icon  to align the trigger to the left. Click on the timebase 
expansion  or compression  buttons in the display control area to adjust to 
the timebase to exactly match the display settings as shown in the figure above. 

5 The next step is to invoke the Edit Mode. In order to achieve this end, place the cursor 
on the signal zero reference line. The cursor will turn into a move pointer.  

Right click to view the context menu: 

 

6 Note that Edit is the last option in the context menu. Click Edit to enter the graphical 
editing mode. The following dialog box appears: 
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Choosing Yes will invoke the graphical editor. 

We have already discussed the implications of limited Edit mode capabilities in the 
previous section. 

7 Click Yes. The waveform graphical editing mode is now invoked.  

Following the procedure given in the previous section, select the portion of the trace to 
be copied. This is achieved by positioning the cursors at the desired locations on the 
trace.  The display below shows one such selection: 

 

Observe that we have selected the middle portion of the signal to be copied. 

8 Right click anywhere on the display (except the zero reference line). You will see the 
display context menu.  Click on Copy.  The screen will appear the same but the selected 
portion of the trace will be copied to the memory buffer: 
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9 Hide the right cursor by clicking on the respective icon  in the toolbar.  After hiding 
the right cursor, drag the left cursor to place it at the insertion point on the trace.   

Next, right click anywhere on the display except the zero reference line. The reference 
context menu will appear: 

 

10 You can see that the Cut and Copy commands have been disabled.  Only the Paste 
command is shown enabled at the bottom of the display context menu. 
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Double click on Paste.  The copied portion of the trace will be pasted at the cursor 
location as shown below: 

 

11 The part of the trace copied is again pasted at the end of the signal.  Hide the left cursor 
by clicking on the left cursor button in the toolbar. The GageScope® display will show 
as follows: 
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12 When finished, you must exit the Edit mode.  Right click on the zero reference line. The 
reference context menu will appear.  The check mark besides Edit command shows that 
the Edit mode is currently active.   

 

13 Click on Edit to deactivate the Edit Mode.  The GageScope® window will appear as 
follows:  

 

Observe that the normal operation has commenced since all disabled controls have been 
enabled. 
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